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Message from the Team

We'd like to thank you for using FusionDebug, the interactive debugger for ColdFusion.
We're very excited to be able to bring you this groundbreaking product!

We believe FusionDebug defines the state of the art for ColdFusion debugging and
provides a very important tool in the current ColdFusion development world. With the
advent of ColdFusion-driven Flex applications and ColdFusion's own powerful object-
oriented features, an interactive debugger has become essential for effective and
productive debugging. We believe you will be able to use FusionDebug to accelerate
your development and improve quality across the whole software cycle.

If you're coming to us from Dreamweaver, CFEclipse or even a text editor, don't worry.
You don't have to use FusionDebug or Eclipse fo edit pages, or change your
development platform. You can sfill develop with Dreamweaver or whatever your
favorite editor happens to be, and jump into FusionDebug whenever you need to
work out a problem. FusionDebug is able to use your files from whatever software you
used to create them.

Writing an inferactive debugger is no small undertaking, and for a scripting language
like ColdFusion it's been a remarkable and rewarding challenge. We want you to be
aware that there are some limitations due mostly o the way ColdFusion compiles and
optimizes pages prior to running them. When stepping through code, you may
occasionally see the current line jump back to the start of a tag, or move to a location
you didn't expect. In these cases, FusionDebug will of course continue to display
accurate variable and expression data.

We will of course continue to improve FusionDebug and find solutions to such issues in
future releases, but we believe they have only a minimal impact when compared to
the huge benefits and productivity gains FusionDebug delivers.

Finally, we'd like to ask you for your support. We want to make FusionDebug as good
as it possibly can be and you can play the most important role to help us to help
everyone. Please provide us with feedback on problems, features and ideas at the
following location: http://www.fusion-reactor.com/contact.htiml; we fruly appreciate
it.

Thank you!

The FusionDebug Team
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1 What's New in 2.0

We're excited to be able to bring you FusionDebug 2.0, and we'd like to thank our users for
the many great suggestions and bug reports you sent us — we fruly appreciate it! Here's a
quick rundown of what's new in 2.0.

Source Code Lookups

We have extensively refined how FusionDebug looks up source code. We also now provide
immediate feedback in the Breakpoints View about exactly which file on the server contains
the breakpoint, or whether a server file could not be found.

We've completely redesigned the Mappings tab of the configuration dialog (which is now
called Source Code Lookups) to make it easy to add lookups for all projects, and for specific
Eclipse folders.

Where necessary, we've extended this user manual with appropriate sections which
infroduce the concept of Source Code Lookups (“Source Code Lookup”, on page 20, and a
full explanation “The Source Lookup Tab” on page 41).

This should result in far fewer cases of breakpoints not firing, and fewer cases of FusionDebug
asking you to find a file manually.
Debug Perspective

We've added a FusionDebug Perspective, which collects together all the views you need to
begin debugging ColdFusion applications. This removes the need to customize the Debug
Perspective, and should get you up and running with FusionDebug faster.

Installer

In addition to the standard Eclipse Software Install/Update Manager package which can be
installed directly within Eclipse from our website, we're also now providing a traditional
installer, which will be more familiar for many users.

Server Configuration Wizard

We're also providing a Server Configuration Wizard which is capable of updating your
ColdFusion/JRun server configuration file in order to allow ColdFusion to accept connections
from FusionDebug. This should make setting up your configuration easier; of course, you're still
free to edit this file by hand (and we provide comprehensive instructions on how to do this).
Inspect Expressions

Instead of creating watfch expressions, it's now possible to highlight an expression in your code
and have it immediately evaluated and displayed in a dialog box.

Icon changes

We've unified our use of the Red Bug icon (you can see him at the bottom of this page)
across the board: in dialogs, menus and documentation. This should make identifying
FusionDebug components within Eclipse much easier.

Bug Fixes

We've also worked hard to eliminate the bugs which you reported fo us from our 1.0.0
release.
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2 Getting Started

Before we get into the manual, you might like to know that we have several Captivate videos
on line af the following URL:

hitp://www.fusion-reactor.com/fusiondebug/gettingStarted.htmi

These will show you how to set breakpoints, use stepping, watch expressions and examine
variables. You can download the files used in the videos from:

http://www.fusion-reactor.com/fusiondebug/helpDocs/FusionDebugExamples.zi

For more details on any of the subjects covered in these videos, please refer back to this
manual.

@ INIIEN GRAL
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3 Infroduction & Concepts

Welcome to FusionDebug, the interactive debugger for ColdFusion applications. This
document infroduces the concepts you'll need to start debugging your own applications,
guides you through the configuration process and gives you some helpful hints on using
FusionDebug to best effect.

FusionDebug is delivered as stand-along install package, or as a plugin for the Eclipse
Platform. Eclipse is a universal framework for applications — not just debuggers — and provides
many features that make developing interactive applications simpler. We selected Eclipse
because it already has a good tradition of being a comprehensive, well-supported, stable
platform, and a proven architecture for debuggers.

Many other plugins are available for Eclipse — CFEclipse, for example, is a leading
environment for writing ColdFusion scripts. If you have CFEclipse installed too, FusionDebug
will integrate with that environment when it needs to open an editor. If not, don't worry —
FusionDebug will also use the standard Eclipse text editor.

Please note that, as our recommended CF editing plugin, we give you the option of
automatically installing CFEclipse directly from our stand-alone install package.

3.1 Why Do | Need a ColdFusion Debugger?

Debugging ColdFusion pages usually requires using lofs of <cfoutput> statements, <cfdump>
or writing to log files. But as applications grow more sophisticated with the addition of object
oriented components, and the integration of Flex, it's becoming increasingly difficult to solve
complex problem:s.

FusionDebug solves these problems by allowing you to suspend any page or component
during its execution and see all the variables used by that page. You can add specific
watch expressions, you can even set variable values while the page is suspended. Pages
can then be single-stepped or resumed.

You may think you don't need a ColdFusion debugger because you've never used one.

FusionDebug will change the way you work.

3.2 What Do | Need to Get started?

The easiest way to get started is by downloading our complete installer. This will let you installl
everything you need to get developing: Eclipse, CFEclipse and FusionDebug.

If you are already using Eclipse or Flex Builder 2, we have a second installer which you can
use to automatically add these plugins into your existing environment.

Additionally, both installers give you the option of running the Server Configuration Tool which
will automatically update your server settings to enable debugging.

If you do use the complete installer, once you run FusionDebug, you will see a short set of
simple instructions which will get you debugging in minutes.

To download FusionDebug or find out about other ways to install, visit our website at:

hitp://www.fusiondebug.com/
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4 Debugger Concepts: Quick Tour

We know that not everyone's used a debugger before, so we're providing this section o
infroduce all the required concepts to get you started. We've put in some screenshots to
show you what each item looks like. Don't worry about finding these things in Eclipse yet —
we'll cover that in later sections.

4.1 Debug Configuration

A Debug Configuration is a collection of parameters which allow FusionDebug to find,
connect to and use a Debug Target — a ColdFusion instance - as well as enabling
FusionDebug to look up your source code whenever it needs to.

= Debug

Create, manage, and run configurations

FusionDebug needs to know about your CF Server to be able to debug your application

e R——
=] - 5=
= X O MName: | Simple Debug Profile

type filter text —
; Connect # Source Code Lookup | 2] Common

& Edipse Application
4 Equinox 0SGI Framework CF Server Hostname and Debugger Port Mumber
= @ FusionDebug
ﬁ Simple Debug Profile
0] Java Applet Port: | 8000
[3] 1ava Application
Ju Junit [¥]cF Server is on Windows (uncheck if the CF Server is on Linux or Unix)
& JUnit Plug-n Test
Z Remote Java Application
iz} SWT Application

Host: | localhost

@ [ Debug ] [ Cloze

Figure 1: The Default Debug Configuration in Eclipse

If you have installed FusionDebug as a complete package (including Eclipse), you will
already have a Simple Debug Profile defined. Simply follow the steps listed in the default
document in order to complete this profile and start debugging.

& s INIIEN GRAL



User Manual FusionDebug 2.0

4.2 Debug Target

The Debug Target is the JRun/ColdFusion instance to which you want to connect to perform
debugging. The Debug Target is specified in the Debug Configuration and appears in the
Debug View. In Figure 2, you can see the Debug Configuration (Local Configuration) and
the Debug Target (1ocalhost:8000).

%5 Debug 2
&
= ¥ Local Configuration [FusionDebug]
FusionDebug (localhost:8000)

Figure 2: Debug Target

4.3 Threads

A Thread is a ‘worker unit' that runs ColdFusion pages. Threads are idle most of the fime, sitting
and waiting for web server connections. When a page is requested, JRun/ColdFusion picks
the next idle thread and gives it the request to execute. The thread's job is then to execute
the script, performing any actions the script requires, then to return the generated page back
fo the web browser. While the thread is busy running a request, it can't handle another
request.

When the thread's job is complete, it returns to being idle.

In ColdFusion, these worker threads are named jrpp-X or web-X where X is a number. You'll
see them appear in the debugger as you learn to pause and inspect them. In Figure 3 for
example, we see that the thread jrpp-1 is handling the request.

4.4 Stack Frames and the Stack

The Stack is a list of pages currently being executed by a thread, along with the current line
number of that page.

%5 Debug 52
Ok = e E
- & Local Configuration [FusionDebug]
=-&#@ FusionDebug (localhost:8000)
=+ jrpp-1
= sayhello.cfm (line:1)
= helo.cfm (line:1)

Figure 3: Stack With Two Frames

You'll see the stack in the Debug View. If you only have a single simple page, the stack will
only contain one element — that page. If you have a more complex architecture, your stack
may contain many elements.

For instance, if you have a simple page — hello.cfm — and you run this page, the stack will
contain just this page.
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If your page calls a sub-tag sayhello.cfm, the stack will contain two levels: hello.cfm and
sayhello.cfm. This scenario is demonstrated in Figure 3. the jrpp-1 thread is handling this
request.

We can see that the page which ran first - hello.cfm -is af the deepest level - the bottom
of the stack.

We call each of these levels a Stack Frame. The stack is composed of frames, which
represent each page in the current call.

4.5 Variables

When a thread is paused, the Variables View shows you all the ColdFusion variables currently
available in the selected stack frame. Using the example above, if you select sayhello.cfm,
the Variables View would show you all ColdFusion scopes and variables available within that
page. By selecting the hello.cfm page you could then see the variables available to that
page, and so on.

=)= Variables i3 Breakpoints | Expressions

Name Value
= % VARIABLES

@ TEXT "Hello from hello.cfm!”
& APDITCATION BEOILIEST

Figure 4: Variables View

Figure 4 shows the Variables View displaying the text variable, which contains a friendly
string.

4.6 Expressions

Expressions are variables you are specifically interested in watching, or expressions you refer
to frequently. The Expressions View allows you to carefully inspect just the variables you're
currently focused on.

The Expressions View is evaluated every time a thread pauses, so you can quickly see how
the variables are changing during the execution of a page. Most ColdFusion expressions are
valid in the Expressions View. Figure 5 shows an Expression View inspecting the
CF_TEMPLATE PATH variable inside the HTTP scope.

Variables | Breakpoints ‘9‘5‘ Expressions %
Y "HTTP.CF_TEMPLATE_PATH" = "C:\Inetpub\wwwroot\cfapp\hello.cfm"

Figure 5: Expressions View
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4.7 Breakpoints and the Current Instruction Pointer

Breakpoints are a key feature of FusionDebug, and instruct FusionDebug to pause any
request whenever it hits the breakpoint. We say that the breakpoint has been hit, or that it
has fired. Breakpoints appear within Eclipse editors in the left margin as small blue dofs.
Figure 6 shows a breakpoint set on the <cfset> tag. Be aware that in order for a breakpoints
to fire, the associated project must be open. Breakpoints within closed projects are disabled.

@3 hello.cfm &2 - 43 sayhello.cfm
<cf sayhello><br>

® <cfset text = "Hello from hello.cfm!">
» kcfoutput>#text#</cfoutput>
<br>

Figure 6: Breakpoint and the Current Instruction
Pointer (CIP)

This is the only way to cause threads to pause inside FusionDebug. Once they are paused,
the Variables and Expressions views come alive and allow you to examine the state of your
application.

Breakpoints can be enabled or disabled (in which case they won't fire). You can remove
them and reset them at any time.

All current breakpoints are displayed in the Breakpoints View. In addition to the exact file
and line, FusionDebug also displays the full path to the file (see section 12.2, “Breakpoints
View”, on page 53). The full path is computed using the Source Code Lookup tab (see
section 4.10 below, and for a full explanation, section 11, “The Source Lookup Tab”, on page
41).

Current Instruction Pointer

The Current Instruction Pointer (CIP) is a small blue right-pointing arrow which appears in the
left margin of the Eclipse editor. It shows you the line of code that ColdFusion is about to
execute. The CIP moves when you execute one of the Stepping commands to show you
exactly which line will be executed next. Figure 6 shows the CIP on the <cfoutput> tag, on
the line immediately below the breakpoint. The CIP is useful during Stepping operations to
help you see what ColdFusion is executing.

4.8 Stepping

Once a thread has hit a breakpoint and paused, you can perform one of four actions on it.
These actions are known as Step actions. They're accessible using the icons atf the top of the
Debug View, as shown in Figure 7.

w Debug
0= (& S i

Figure 7: Debug View with Stepping Tools Highlighted
4.8.1 Step Over =

Step Over simply tells FusionDebug to execute the line of code currently at the Current
Instruction Pointer. No other actions are performed. If the Current Instruction Pointer is
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located at the last ColdFusion statement of a page and there are no other pages in the
stack, the Step Over command is equivalent to the Resume command, and the page will run
fo completion. If there are further pages in the stack, Step Over will execute the command
and return to the next page in the stack (the caller).

4.8.2 Step Into L.

Step Into is useful when the Current Instruction Pointer is located at a ColdFusion tag which
would cause a sub-tag or CFC to be executed. If you execute a Step Into command while
on such a tag, FusionDebug will attempt to locate the source code for that page (or CFC)
and step info it, pausing on the first line of that page.

If the Current Instruction Pointer is not located on a sub-tag or CFC call, this command is
equivalent to the Step Over command.

4.8.3 Step Return _i&

Step Return is only available from within sub-tags and CFC methods, and causes FusionDebug
fo immediately finish executing the sub-tag or method, and return to the calling page, where
execution will pause ready for further Step commands.

4.8.4 Resume (=

Resume causes FusionDebug to start execution of the page once again, until any further
breakpoints are hit, or the page completes normally.

4.9 Terminate &

If a thread is suspended, the Terminate command causes it to be stopped completely. This
command can be used by selecting either a stack frame or a thread - in either case it is the
thread itself which is tferminated.

When terminated, no further execution will take place in the thread, including all pages,
CFCs and objects associated with that request, and nothing further will be returned to the
browser. This might be useful to cancel a thread which is about to do something destructive,
or begin a time-consuming fask.

Caveats

There are a couple of points fo be aware of with the Terminate command.

« To be as reliable as possible, FusionDebug uses a very harsh method of halfing the
thread. This stops the request exactly at the point at which it's currently suspended,
and cancels all further execution. If you have database transactions pending, they
should be rolled back automatically. However, Terminate itself does not guarantee
this.

- Terminate may not be effective during the following types of operations:

« CF/CFC pages using Java objects via the <cfobject> tag, which are executing
nafive methods (used for things like file and socket operations)

+ CF/CFC pages performing file operations themselves
- CF/CFC pages waiting for data from a socket (e.g. gateway pages etc.)

In these situations, Terminate may either be delayed until these operations complete,
or may not be effective at all. However since this command is only available when a
thread is stopped, these situations should only arise rarely.
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4.10 Source Code Lookup

When you set a breakpoint within a ColdFusion source file, FusionDebug must franslate the
breakpoint information into a form that ColdFusion can understand.

To do this, FusionDebug must know exactly where the page is on the server.

When a breakpoint fires, or a stepping action occurs, the reverse must also happen:
FusionDebug must translate the debugging data from the server intfo a form FusionDebug
can use.

Pages can be addressed in many different ways (e.g. Web services, CFCs and subtags), and
the same name may occur many times on your server (e.g. Application.cfm). When dealing
with this name, FusionDebug needs an unambiguous way of telling which page is which.

The first way FusionDebug differentiates different pages is using the Eclipse Folder Structure,
but that's not always enough: some projects have the same structure — framework-based
projects especially.

So in order to provide another level of checking, FusionDebug needs to know where on your
server these pages are and to which Eclipse project these paths are associated.

The Source Code Lookup ftab allows you to enter one or more Lookups. These lookups
enable FusionDebug to accurately find files when you set a breakpoint, and when it needs to
open a source file, for example during a Step Into operation.

The Source Code Lookup system is explained in much more detail later, in section 11, “The
Source Lookup Tab” on page 41.
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5 Installing FusionDebug

5.1

This section provides guidance on getting FusionDebug up and running on a simple project.
You should follow the steps in order and learn how fto control FusionDebug on this small
project before using it on your own.

The files for this project are available here:

Using the Complete Installer

The complete installer from our website supplies Eclipse and FusionDebug, together with
optional component CFEclipse.

If you wish to install Eclipse separately or you with to install FusionDebug into Flex Builder 2
then please read the next sections.

5.2 Installing the Eclipse Platform

If you already have Eclipse 3.1 or 3.2 installed — perhaps because you have Macromedia Flex
2 Builder installed already — and are comfortable with Perspectives and Views, you can skip
ahead to section 5.4 - “Installing the FusionDebug Plugin®, on page 24.

5.2.1 Downloading and Running Eclipse

If you have not already installed Eclipse, you will need to download and install it from the
Eclipse website:

http://www.eclipse.org/downloads

Be sure to select the Eclipse SDK. At the time of going to press, Eclipse 3.2.1 is the current
revision. We have tested FusionDebug thoroughly with Eclipse 3.2.1 and recommend this
platform for FusionDebug.

Eclipse is provided as a zip (compressed) file. When the download has completed, you
should uncompress this file to a folder on your hard disk.

Once uncompressed, Eclipse can be started by double-clicking the eclipse.exe program
(Windows) or running the eclipse script from a terminal window (Unix). When Eclipse starts
up for the first time, it will display the Welcome screen, as shown in Figure 8.

You may like to place a shortcut to Eclipse on your desktop to make it easier to launch in
future.
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| Java - Eclipse SDK mEX]

jte Search Project Run Window Hep

Figure 8: Eclipse Welcome Screen

After launching for the first fime, Eclipse will ask where it should locate your Workspace. This is
an Eclipse storage area where new projects will be created by default, and where Eclipse will
store its settings. Accept the default, and optionally check the box marked “Use this as the
default and do not ask again”.

Don't worry if you have existing ColdFusion projects on your disk — Eclipse will be able to use
those too, even if they are not located in the workspace. You can also change the location
of the workspace later.  You may take some of the Eclipse tours by selecting one of the
round icons.

Proceed directly fo the workbench by selecting the Workbench icon (the rightmost round
button) or the white 'X' on the Welcome tab.

5.3 Views and Perspectives

Eclipse is now installed and ready for use, looking something like Figure 9. This is the Java
Perspective. You can see the currently-active perspective at the top-right of the window.
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& Java - Eclipse SDK QE}
File Edit Source Refactor Mavigate Search Project Run Window Help
$-0 Q- i BBEG- (&S @3- © G- Oy
E Package Exp... &2 . Hierarchy| = 5 = 0|8 outline 52 ¥ =0
BE ~ An outiine is not avaiable.

{2 Problems 52 . Javadoc Declaration ¥ =0
0 errors, 0 warnings, 0 infos
Description Resource | Path Location

: 0 CF App

Figure 9: Eclipse Java Perspective

An Eclipse Perspective is a collection of related Views. You can see that this perspective
contains (amongst others) the Package Explorer view on the left, and the Outline View on the
right.

Views can easily be dragged into different locations.

If you accidentally close a view, it can be reopened again by selecting Windows -> Show
View. If it doesn't appear in that menu, selecting Other will allow you to find the view in the
complete list.

After installing FusionDebug, the FusionDebug Perspective will be available. This contains all
the views you will need to debug ColdFusion code.
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5.4 Installing the FusionDebug Plugin
The FusionDebug Plugin is supplied in two different ways:

® As an on-line Eclipse Software Install/Update Manager package
This package is installed entirely within Eclipse using the Eclipse Software Install/Update
Manager. If you are familiar with Eclipse, or don't need the additional configuration
supplied by the installer (see below) use this method.

® As a standalone installer
This package is supplied as a standard install executable, like most other software. It is
able to locate an existing Eclipse installation and install or update the FusionDebug
located there. The installer also supplies the FusionDebug Server Configuration Wizard,
which can modify the jvm.config file of an existing ColdFusion installation in order to
allow it to accept debugging connections. If you are not familiar with the Eclipse
Software Install/Update manager, or you'd like the installer to update your ColdFusion
configuration for debugging, use this method.

5.4.1 Installation via the Eclipse Software Install/Update Manager

Once Eclipse is installed and configured, we are ready to install FusionDebug using the
Eclipse Update Manager. This will download, check and install the FusionDebug package,
and makes upgrading FusionDebug easier in the future.

« In Eclipse, select Help -> Software Updates -> Find and Install to begin the process.
This activates the Install/Update dialog, shown in Figure 10.

& Install/Update
Feature Updates 3 ,—
Choose the way you want to search for features to install i )")-_

() Search for updates of the currently installed features

Select this option if you want to search for updates of the features you already have
installed.

(®) Search for new features to instal

Select this option if you want to install new features from existing or new update sites.
Some sites may already be avaiable. You can add new update site URLs to the search.

Figure 10: Eclipse Install/Update Dialog

« Select Search for new features to install, and click Next.
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Select New Remote Site to add the Intergral FusionDebug software site. In the dialog
which appears, enter

«  Name: FusionDebug Update Site
« URL: http://www.fusion-reactor.com/fusiondebug/update
... then click OK.

In the Install/Update dialog, ensure the FusionDebug Update Site is checked, then
click Finish.

The Update Manager will connect to fusion-reactor.com and locate the new
soffware. A search dialog will appear, similar to that pictured in Figure 11. Place a
check mark against the fopmost free element (“FusionDebug Update Site”) and click
Next.

é Updates
Search Results e |
Select features to install from the search result list. ;).‘"’
Select the features to install:
= ] 4l F Deselect Al
Select Required

FusionDebug Update Site

1 of 1 selected.

Show the latest version of a feature only

D Fiter features included in other features on the list

Figure 11: Eclipse Update Search Results Dialog
Read the license agreement which appears in the next step, and if you accepft its
terms, select | accept the terms in the license agreement and click Next.

Finally, click Finish to complete the process. The update manager will download and
install the package automatically (about 14 MB).

When the Feature Verification dialog appears, click Install All.

Eclipse will ask if it should restart the Workbench. Answer Yes to this question. The
workbench will restart.

5.4.2 Installation via the Standalone Installer

Instead of using the Install/Update Manager, you may prefer to use the Standalone Installer.
This installer will add the FusionDebug plugin into an existing Eclipse installation. You also have
the option of installing the Server Configuration Wizard which can be used to automatically
configure a local copy of ColdFusion for debugging.

The Installer can also be used to upgrade existing FusionDebug installations, even if they were
previously installed using one of the other install methods.

The installer has the following steps:
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- The Server Configuration Wizard initially displays its welcome page. Click Next.

- The Destination Directory dialog will appear. Enter the install path for FusionDebug.
Note that this is not the Eclipse path where FusionDebug will be installed: it is the
location where the FusionDebug User Manual, Server Configuration Wizard and
Uninstaller will be installed. Click Next.

« The installer now displays the Select Components dialog which can be seen in Figure
12. The installer can be used fto update a copy of Eclipse, install the Server
Configuration Wizard, or both. Once you have selected the components you wish o
install, click Next.

% Setup - FusionDebug 2.0.0 (&=
]

Select Components 3
Which compaonents should be installzd?

Select the components you want to install; clear the components you do nok wank ko
install. Click Next when vou are ready to continue,

¢k FusiorDebug
FusionDebug is an Eclipse based debugger for ColdFusion applications.
i CrEdipse

e CFEclipse is an Open Source plugin for the Eclipse platform that
provides a professional quality IDE for CFML developers.

¢k server Configuration Wizard

The Server Configuration Wizard lets you easily configure your CF
Servers for use with FusionDebug. Install this component if the WM
configuration files of the CF server are located on this computer or can
be accessed via a network share.

[ < Back ][ Mext = ] [ Cancel

Figure 12: Installer Select Components Screen

- The Select Eclipse dialog will appear next. If you opted to install the Eclipse plugin
from the previous screen, then you should now enter to the path to your Eclipse
installation. On Windows the path will typically be something like “C:\Eclipse" or
“C:\Flex Builder 2".Click Next.

- The Start Menu Folder dialog will now appear. Select where you want FusionDebug to
appear in your Start Menu, or select not to have FusionDebug added to your Start
Menu if you prefer. Click Next.

- The Additional Tasks dialog appears next. Check the boxes displayed to specify if the
installer should create Deskiop and Quick Launch icons. Click Next.

- FusionDebug is now installed. If you opted to also install the Server Configuration
Wizard then you will have the opftion to run it immediately. Click Finish.

5.4.3 The Server Configuration Wizard

If you choose to run the Server Configuration Wizard directly from the installer, or if you start it
later from the Start Menu, it will guide you through the following steps:

- Initially you will see a Welcome dialog which will explain what the wizard intends to
do. Click Next.

- The Server Configuration Wizard will attempt to find any local ColdFusion servers on
your computer (see Figure 13). Simply select the one you want to enable for
debugging. If your ColdFusion installation is not listed then use the Browse button to
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locate the jvm.config file associated with your ColdFusion server. (To make the
necessary changes, the Server Configuration Wizard must have write access to this
file.) Click Next.

<5 FusionDebug Server Configuration Wizard ==

Please choose the Java Virtual Machine configuration file of the server you want to
configure fram the list below.
To add an entry that is not in the list click on the Browse... hutton.

i3\ CFusionMXrunkime'ibint jvm. config

A Fusiontiruntime)bin'jvm. config

Click Back to return to the previous screen, click Next to continue, click Cancel ko exit this wizard,

[ < Back H Next = ][ Cancel ]

Figure 13: Configuration Wizard jvm.config Select

« The Port Select dialog lets you pick which port the Debugger will run on. Select a free
port and note down this number as you will need it when setting up a debugging
profile within Eclipse. Click Next.

« The Server Configuration Wizard will now update your CF configuration. Once
completed, click Next.

- The final page lets you know that a backup of your jvm.config file has been written
and where it can be found. Typically they will be stored under your ColdFusion installl
directory under /runtime/bin/jvm.config.bak. Click Finish fo close the wizard.
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6 Manually Setting up Java for Debugging

If you have already used the FusionDebug Server Configuration Wizard to set up your
ColdFusion environment for debugging, you may safely skip this step and go directly to
section 7, "Introducing the FusionDebug Perspective” on page 31.

This section illustrates how to configure ColdFusion to allow FusionDebug connections. We will
use JRun as our example, as this is a very common ColdFusion platform.

6.1 Setting up ColdFusion for Debugging

This procedure adds the required debugging parameters to a standard ColdFusion (JRun)

installation.
1. Stop all running ColdFusion services.
2. Locate the Java configuration file jvm.config'.
« This can be found in the following location:
+  Windows: C:\CfusionMX7\runtime\bin\
« Unix standalone: /opt/cfusionmx7/bin/
Unix multi-instance:  /opt/jrun4/bin/
3. Make a copy of this file, and store the copy somewhere on your disk. In case of
problems, you can restore the copy to this location.
4. Open this file in a text editor (e.g. Notepad).
Locate the line java.args. These are the seftings used to start the Java Virtual
Machine, in which ColdFusion runs.
6. Remove this option:
. -XX:+UseParallelGC
7. Add these options:
. -Djava.compiler=NONE -Xnoagent -Xdebug
-Xrunjdwp:transport=dt socket, server=y, suspend=n, address=8000
8. All options must be on the same line. Be careful not to infroduce any line breaks. The
following line is an example of a complete java.args parameter line:
java.args = -DJINTEGRA NATIVE MODE -DJINTEGRA PREFETCH ENUMS -Xmx512m
-XX:MaxPermSize=128m
-Dsun.io.useCanonCaches=false -Dcoldfusion.rootDir={application.home}/../
-Dcoldfusion.libPath={application.home}/../1lib -Djava.compiler=NONE -Xnoagent
-Xdebug -Xrunjdwp:transport=dt_socket,server=y,suspend=n,address=8000
-Dcoldfusion
.classPath={application.home}/../../classes, {application.home}/../lib/updates, {applic
ation.home}/../1lib/, {application.home}/../gateway/lib/, {application.home}/../wwwroot/
WEB-INF/cfform/jars
9. If you have other applications running on port 8000, change the port address to a free

port. Make a note of the new port

10. Start all ColdFusion services.

1 For non-JRun installations, this file may be named differently. Refer to your J2EE platform
documentation for more information on changing the Java options used during startup.

%29
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For ColdFusion multi-instance installations, there can be an issue with each instance
aftempting to use the same jvm.config file, causing a port conflict as the second and
subsequent instances come up. For the most up-to-date information on avoiding and
working around this limitation, please check our support area at:

http://www.fusion-reactor.com/fusiondebug/support.html
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7 Intfroducing the FusionDebug Perspective

After installing FusionDebug, a new Eclipse perspective is available. The FusionDebug
Perspective is illustrated in Figure 14, and can be opened by selecting Window -> Open
Perspective -> Other and selecting the FusionDebug perspective.

] FusionDebug - Eclipse SDK Q@
Fle Edit Navigate Search Project Run Window Help

-0 Q- i@ 1 EEI [/ | § FusionDebug | 7

%5 Debug &2 = O ||e9= variables 2 “._Breakpoints| Expressions 2@~ 0

-~
%5 Navigator &2 Zm =
S~
@ Internal Web Browser &% =
CRES v e B
=

Figure 14: FusionDebug Perspective

This perspective is designed to get you started debugging ColdFusion pages. The views and
their functionality are described more fully in section 12, “Reference” on page 51. Broadly,
they are as follows:

Debug View - shows the current Debug Target to which FusionDebug is connected,
along with any Stack Frames which correspond to paused pages.

Variables — when a page is suspended, this view shows all the ColdFusion scopes and
variables currently available to the page.

Breakpoints — lists all the breakpoints currently in use, together with their exact location
on the server.

Expressions — lists all the expressions currently being watched. This view is updated
whenever ColdFusion pauses due to a breakpoint or stepping action.

Navigator — shows all projects and folders currently in the workspace.

Editor Area - this is the largest area in the Perspective, and is initially empty. Any
editors opened will appear here.

Internal Web Browser — this is a simple web browser and can be used to call pages to
frigger breakpoints.
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8 Configuring a Project in Eclipse

If you have installed FusionDebug using the Complete Install then you will automatically have
a project and default debugging profile defined. In order to complete your installation,
simply read the instructions shown on the initial start page.

Before Eclipse can be used to debug ColdFusion applications, you must configure a project
in the Navigator. This enables FusionDebug to locate the correct source code to respond to
debugging events like breakpoints, steps etc.

8.1 Creating a new Eclipse Project

In our example, we have installed some test files inside the default IIS web folder, and we're
going to use these as the basis of our project.

The files are located in c: \inetpub\wwwroot\cfapp.

1. Start Eclipse if it's not already running, and switch to the FusionDebug Perspective if it
does not open automatically (Eclipse remembers the last perspective you used
before you shut it down last).

In the Navigator view, right click and select New -> Project.
The New Project wizard appears.

Open the General tree branch, and select Project.

A

Enter a meaningful name for your project (we're using “CF Test Application”), and
uncheck the option 'Use default location'.

- Since we dlready have existing files, we can use these instead of starting a new
project in the workspace.

6. Locate the folder containing the files we want to create a new project for (in
c:\inetpub\wwwroot\cfapp) using the Browse button, and click OK.

7. Click Finish to complete the wizard.

After completing the wizard, the new project appears. You can double-click on any files
within the project to begin editing them. Do not delete the .project file — that's an Eclipse
internal file used to keep track of your project.

8.2 Creating a FusionDebug Configuration

This section shows you how to set up a FusionDebug configuration to connect to your local
machine and begin debugging. It's very important to carefully read and understand these
instructions, since setting up a working FusionDebug Configuration is a key step.

1. Open the Debug dialog using the Run -> Debug menu opftion.

2. Right-click the FusionDebug element on the left of the dialog and select New. The
FusionDebug configuration page appears in the dialog.

3. Enter a meaningful name in the Name: field. This should be something which
describes this configuration. We're using “FusionDebug Local Connection”.

4. Since we're going to connect to our local machine, leave the Host as it is -
localhost. The port defaults fo 8000. If you didn't change it when running the Server
Configuration Wizard (see section 5.4.3), or setting up JRun for debugging (see section
6.1), leave it as it is. Otherwise, enter the same port here as you used previously.

5. Check the first option.
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« CF Server is on Windows
This option tells FusionDebug to connect to a Windows system. Our system is
Windows XP Professional, so we leave this checked.

Before we can complete the configuration, we must add at least one Source Code
Lookup to tell FusionDebug where the ColdFusion files are located on the server.
Click on the Source Code Lookup tab to bring up the Lookup Table.

This table tells FusionDebug where the files are located on the server. You must enter
at least one rule in this table.

When you launch the configuration later, FusionDebug will compute the actual
locations of the breakpoints, and display them along with the breakpoints
themselves in the Breakpoints View. Since we only have one project, we'll use the
global <All Projects> rule and the c:\inetpub\wwwroot\cfapp folder. Enter this
datain the upper area and click Add. Figure 15 shows the Source Code Lookup tab
containing the All Projects rule.

fa Debug ‘

&

Create, manage, and run configurations
@ There must be a least one source code lookup defined!

- =y
TEX| B3

type fiter text

Name: | Local Configuration

4@ Eclipse Application
4 Equinox OSGI Frame.
=14 FusionDebug
& Local Configuratio
4l Java Applet
1 Java Application
Ju JUnit
Ji JUnit Plug-in Test
T, Remote Java Applicat
B+ SWT Application

& Connect | 3 Source Code Lookup
Add/Modiy

=l Common

Source Code in this Eclipse Project/Folder

Alprojers> v

Is placed in this CF Server Folder
c:\inetpub\wwwroot\cfapp

Current Source Code Lookup
Edlipse Project/Folder

<]

CF Server Folder

Figure 15: Sefting the 'All Projects' Mapping

Because the Source Code Lookup tab is so important, we've explained it in more
detail in its own section, 11, "The Source Lookup Tab” on page 41, and the exact
meaning of the Source Lookup Tab is discussed in section 12.5, *Configuration
Dialog" on page 57.
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7. With the configuration looking similar to Figure 16, select Apply.

& Debug X
Create, manage, and run configurations .
FusionDebug needs to know about your CF Server to be able to debug your application

R

|| Name: | Local Configuration
type fiter text]
@ Edlipse Application
& Equinox OSGi Framewo
= FusionDebug

[§ Connect - §F Source Code Lookup = Common |

CF Server Hostname and Debugger Port Number

§ Local Configuration &=ty localhost
5l Java Applet Port: | 8000
[31 Java Appiication
Ju JUnit

 JUnit Ph s CF Server is on Windows (uncheck if the CF Server is on Linux or Unix)
Jt Junit Plug-in Te:

[, Remote Java Applicatior

Compie CF pages in debug friendly mode whie FusionDebug is connected
Bl SWT Application

[] Display very detailed Java information (Java Expert Mode)

(] I | 2

Figure 16: FusionDebug Configuration for Local Machine

8. Finadlly, select Debug. The dialog should disappear, and FusionDebug should
connect to the local Java instance. If this succeeds, the Debug View will display the
debug configuration and debug target, as shown in Figure 17.

%5 Debug 1
y e
= §# Local Configuration [FusionDebug]
FusionDebug (localhost:8000)

Figure 17: Successful Connection
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9 Exploring FusionDebug

User Manual

We believe a static manual isn't the best place to demonstrate what FusionDebug can do, so
we've prepared some Captivate videos instead.

hitp://www.fusion-reactor.com/fusiondebug/gettingStarted.htmi

These will show you how to set breakpoints, use stepping, watch expressions and examine
variables. You can download the files used in the videos from:

You should have a look through the reference sections to clear up any questions you might
have, and feel free to drop us a line to the support address if there's anything you feel isn't

addressed.

Here's a quick rundown of the main features.

:fﬁ Debug =2
]2 S
= & Local Configuration [FusionDebug]
=-&# FusionDebug (localhost:8000)
=-of jrpp-5
:MyComponent.cfc : METHOD() (ine:1);
step_into.cfm (line:5)

(%)= Variables i3 . Breakpoints Expressions

Name Value
= & VARIABLES
= & CATALOGINFO Struct
% Binding "Paperback”
@ ISBN "0618346244"
% Language "English"
% Publisher "Houghton Miffin; Boxed edition
Variables | % Breakpoints £3 . Expressions KBFPAW| BmEE Y C

e MyComponent.cfc [line: 5] [Server File: c:\inetpub\wwwroot\cfapp\MyComponent.cfc]

[] © doimport.cfm [line: 1] [Server Fie: c:\inetpub\wwwroot\cfapp\doimport.cfm]
@ step_into.cfm [line: 5] [Server File: c:\inetpub\wwwroot\cfapp\step_into.cfm]
@ types.cfm [line: 45] [Server File: c:\inetpub\wawwroot\cfapp\types.cfm]

[} © ivariables.cfm [line: 5] [Server Fie: c:\inetpub\wwwroot\cfapp\variables.cfm] |

variables | Breakpoints |57 Expressions &2

e
=7
gc,;y ||mWar—2|| i ||1[:|||

=Y "URL" = Variable Scope

@ FAVOURITETOOL = "FusionDebug"

Explore Stacks... FusionDebug shows you exactly
what CFCs, pages and objects are involved in
your request. If you're inside a CFC function, the
name of the function is also displayed.

Explore Variables... FusionDebug shows you all
ColdFusion variables scopes, including handy
Current Query, local Variables and Function
Local variables too.

Explore Breakpoints... FusionDebug keeps track
of all your project breakpoints, allowing you to
delete them one by one, disable selected
breakpoints, or skip them altogether. The
Breakpoint View also shows exactly which server
file the breakpoint is in.

Explore Expressions... You can add almost any
ColdFusion expression and watch the value. The
values are updatfed in real time, whenever a
thread steps or pauses, so you can see exactly
what ColdFusion sees. Addifionally, you can
Inspect any variable at any time by highlighting it
in your code and selecting “Inspect Expression”
from the right-click menu.
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10 Installing and Activating a License

FusionDebug runs for 20 days without requiring an active license. After this period, you will not
be able to configure FusionDebug or launch any debug configurations unfil a license is
installed and activated.

To acquire a license, please visit

htp://www.fusion-reactor.com/fusiondebug/buy.html

10.1 Installing a License
When you have received your license file, it can be installed as follows.
1. Open Eclipse and select Window -> Preferences.
2. Open FusionDebug and select the License node.
3. Use the Browse button fo locate your license file, and select Open.
4. Finally, click Install License.
« You now have 10 days to activate this license.

- If you have web access from this PC, we recommend immediately activating the
license.

10.2 Activating a License Automatically

If you have web access from the licensed PC, you can perform an automatic activation as
follows.

1. Open the License panel as described above.

2. Click Activate License.

10.3 Activating a License Manually
A license can be manually activated as follows:

1. Open the License panel as described above.

2. Select the Manual Activation link, and note down the Activation Input String
- Do noftrestart Eclipse until you have completed this procedure.
On a PC with web access, visit the URL mentioned in the dialog.
Enter the Activation Input String info the form and select Submit.
When the page returns, note down the Activation Key.
On the PC to be licensed, enter the Activation Key info the dialog box.
Click OK.

N o o~
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11 The Source Lookup Tab
11.1 What is the Source Code Lookup Tab?

The Source Lookup tab is used to tell FusionDebug where the source files in your Eclipse
projects are placed on to your CF server.

Debugging Machine CF Server Machine

-I-1=% Example Project

2 .project

B helle\World, cfm [=) %e® Local Disk (C:)
--1=> Tags Project =I5 CRusionMX

\Z| hello.cfm H"“EI ) wwwroot

[E world.cfm T [Ctags

Eclipse Project/Folder CF Server Folder
Figure 18: How Lookups are Used

FusionDebug uses the source code lookup rules to tell the CF server where to set breakpoints
and to tell Eclipse which source code to display when a breakpoint is hit. Breakpoints are set
within Eclipse but must also be transferred to the CF server for them to become active.

By configuring your Source Code Lookups, FusionDebug can support multiple Eclipse projects,
mapped CFCs and include files and provide support for the various frameworks that can be
used with CF.
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11.2 What is a Lookup?
Often, the structure of the files in your Eclipse projects is not the same as the structure when
deployed to your CF server. This leads to the problem that FusionDebug is unable to work out
which files in Eclipse relate to which files on your CF server. This problem is solved by creating
Source Code Lookups in your FusionDebug configuration. Each lookup consists of an Eclipse
project path and the absolute path to the folder on the CF Server that contains the same

files.

(=] 4 Local Disk (C:)

l = @CFuﬂonMJ(
N @ _——

5 [ togs

= E Elump'la?m{g:l
s U example.cim

e i&lugs

|
{=| hellocim |

i

b LEJ world.cfm

Z s Project
= B External Tags Fro) |II |

LJ world.cim

e

A

SRE ILEJ example.cfm

Eclipse Project/Folder CF Server Folder

Figure 19: How Lookups are Used

If you take the Eclipse Project/Folder paths and absolute CF server paths form Figure 19, then
your Source Code Lookups will look like this:

| CF Server Folder |

Eclipse Project/Folder
C:\ CFusionMX\ wwwroot

Example Project
External Tags Project C:\ CFusionMX\ wwwroot' tags

Figure 20: Setting Lookups for the Example
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11.3 How Do | Find the Source Code Lookup Tab?

There are two ways to find the Source Code Lookup tab. Firstly, you can open the Run menu
and then select the Debug... item.

t |Run Window He

[

LYY ms

T Use Step Filters Shift+F5

@, Run Last Launched Ctrl+F11
%, Debug Last Launched Fil

Run History b
Run As 3
Run...

Debug Histary 13
Debug As 3

Figure 21: The Run -> Debug Menu

Alternatively, you can go to the little green debug icon in your Eclipse toolbar and click the
small arrow on its right-hand side. This brings up a small menu and you can select the Debug...

item from there.

-0 -
Debug As 4
%5 Debug... %

Organize Fawvorites...

Figure 22: The Eclipse Toolbar Debug Dropdown

Once the debug dialog is visible you can bring up the Source Code Lookup tab by opening
the FusionDebug item and clicking on an existing debug profile, or by right-clicking on the
FusionDebug item and selecting New from the menu.

wr CCIpSE ADPHICaTon

# FusionDebug
5] Java Applet | Mew %

Figure 23: Creating a New Debug Configuration
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11.4 How do | Use the Source Code Lookup Tab?

Name: | Example Debug

# Connect ; Source Code Lookup l =1 common ]

Figure 24: The Source Code Lookup Tab

The Source Code Lookup tab is split intfo two main sections. The top section allows you to add
or modify lookups.

Add/Modify
Source Code in this Edipse Project/Folder
|Exam|:ule Project j |f j
Is placed in this CF Server Folder
| C:\CFusionMX\Wwwwroot j
add | |

Figure 25: The Source Code Lookup Add/Modify Panel

The bottom section lists all of the lookups currently configured.

Current Source Code Lookup

Eclipse Project/Folder | CF Server Folder | Edit

Example Project C:\CFusionMx Wwwwroot 4

Remove

Figure 26: The Source Code Lookup Rules Panel

To add a lookup, first select an Eclipse project and optionally a folder within that project.
Next, type in the file path of the folder under your CF server that you want to associate with
this Eclipse path. (This is the actual path on the server itself, not the URL which you would type
into a browser.)
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11.5 Example Configurations
11.5.1 Single Machine Setup

The simplest configuration of FusionDebug would be if you had set up your Eclipse workspace
to be the same as your CF webserver root. You would be editing the same files that are being
served and you would only need a single lookup.

Debugging Machine with CF Server

—I-]==+ Example Project -

- tags = e Local Disk (C:)
=l hello.cfm = [C5) CFusionMx
=] world.cfm = L) wwwroot

E .project = [Dtags
\=| helloworld.cfm

CF Server Folder
Eclipse Project/Folder

Current Source Code Lookup

Edlipse Project/Folder | CF Server Folder
@ Example Project C:\CFusionMX 7 wwwroot

Figure 27: Single Machine Setup
11.5.2 Remote Debugging Setup

If you copy your project source files directly to a remote server without changing the structure
then the configuration is equally simple. You create a single lookup from your Eclipse project
to the CF webserver root on that machine.

Debugging Machine CF Server Machine

—-1==+ Example Project i

—|-[z= tags =) Se# Local Disk (C:)
=l hello.cfm = I3 CFusionMX
|=| world.cfm = 3 wwwroot

.project = ) tags

\Z| helloworld.cfm

CF Server Folder
Eclipse Project/Folder
Current Source Code Lookup

Edipse Project/Folder | CF Server Folder |
&) Example Project C:\CFusionMX7wwwroot

Figure 28: Remote Debugging Setup
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11.5.3 Multiple Project Setup

FusionDebug 2.0

Let's say that you have an application which uses a tag library. In Eclipse that tag library is a
separate project which has two folders within it. On the webserver, the contents of both of
these folders end up in a single folder called "tags". You would need three lookups in this
case. One from your application project to the CF webserver root and then another two from

each folder in the library project to the "tags" folder.

Debugging Machine

—|-1== Example Project <.
.project
\=| helloworld.cfm
—|-1e=F Tags Project

CF Server Machine

= %® Local Disk (C:)
= [£5) CFusionMX

— = [ wwwroot

—|-[7= World Tags
=| world.cfm

=]

.project

Eclipse Project/Folder

Current Source Code Lookup
Edipse Project/Folder

—|- 7= Hello Tags --—
B helochn | o O———
=
O

CF Server Folder

| CF Server Folder

&) Example Project
€) Tags Project/World Tags
€ Tags Project/Hello Tags

Figure 29
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11.5.4 CF Mappings Setup

From the CF Administrator you can set up Mappings. These allow you to store cfm code in
any folder on your server. They can then be referenced within your CF pages by using their
logical path. To debug these files you need to add a lookup to the directory path specified in

the CF mapping.

Debugging Machine

CF Server Machine

Active ColdFusion Mappings

Actions Logical Path Directory Path
ICFIDE CAlnetpubwwwroot\CFIDE
Eﬁ@ ftags C:tags

—|-1=% Example Project
[3 Jproject

—|-1z=F Tags Project |
=l hello.cfm
=| world.cfm

=

Eclipse Project/Folder

Current Source Code Lookup
Edipse Project/Folder

CF Adrninistrator

[Z] hellowrorld, cfm \0\

e |

1= Se* Local Disk (C:)

= I CFusionMX
= [C5) wwwroot
== = [3)tags

CF Server Folder

| CF Server Folder

&) Example Project
€} Taos Project

C:\CFusionMX Fwwwroot

C:\tags

Figure 30: CF Mappings Setup

11.5.5 Alternative Webserver Setup

For simplicity, all of the examples so far have used the CF internal webserver. This doesn't
mean that you can't use other web servers. Below is an example of a lookup for IIS:

Current Source Code Lookup

Edipse Project/Folder

| CF Server Folder

Example Project

Figure 31: 1IS Lookup

C:\InetPubwwwroot

User Manual
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Below is a lookup for Apache:

Current Source Code Lookup

Edipse Project/Folder | CF Server Folder |
Example Project C:\Program Files\Apache Group\Apachethtdocs

Figure 32: Apache Lookup

Both of the above examples use the default directory for each webserver but you can also
configure these webservers to use any folder (Virtual Directories). In this case you can just
create a lookup to that folder:

Current Source Code Lookup

Edipse Project/Folder | CF Server Folder
Example Project C:'\myApplication

Figure 33: Virtual Directory Lookup

11.5.6 Linux and UNIX Setup

For simplicity, all of the examples so far have used a CF server on a Windows machine but
FusionDebug can also debug CF servers running on Solaris and UNIX systems. Below you will
see a lookup to a UNIX machine running Apache.

Current Source Code Lookup

Edlipse Project,/Folder | CF Server Folder
Example Project foptfapache htdocs

Figure 34: UNIX Apache Lookup

NOTE: You must tell FusionDebug when you are debugging a Linux or UNIX system. To do this,
go to the Connect tab (next to the Source Code Lookup tab) and uncheck the item which
says "CF Server is on Windows (uncheck if the CF Server is on Linux or Unix)".

Mame: | Simple Debug Profile

# Connect # Source Code Lookup | ] Common

CF Server Hostname and Debugger Port Number
Host: | unixMachine 15

Port: | 8000

I__[:\L;CF Server is on Windows (uncheck if the CF Server is on Linux or Unix);

Figure 35: Setting up for UNIX Debugging
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11.6 Why Are My Breakpoints Not Active?

If you look at the breakpoint view in Eclipse, you may see something like this:

9% Breakpaoints 232

=[] 1= Example Project
@ helloWorld.cfm fline: 10] [Breakpoint not active. Edit Source Code Lookups.]

Figure 36: Breakpoint Not Active

In this case, you need to check your lookup rules in the Source Code Lookup tab. What this
error means is that although you have told Eclipse that you want to set a breakpoint,
FusionDebug couldn't work out in which file on your CF Server the breakpoint should actually
be set. Go back to the Source Code Lookup tab and make sure that your project is
associated with the correct folder on the server. Changes to the Source Code Lookup tab
take effect immediately you select Apply, so this error will disappear as soon as FusionDebug
can compute the real location of the breakpoint correctly.

11.7 Why Is FusionDebug Unable to Display My Source Code?

If you step into a file whilst debugging and instead see something like this instead of your
source code:

¥ hello.cfm &2

Edit Source Code Lookup

FusionDebug is unable to show you the source code for the CF Server
Page /Tag/Component [ C:\CFusionMYwwwrootihella.cfm ]

The typical cause of this problem is either:

1. A missing Source Code Lookup association from an Eclipse Project Folder t

CF Server Folder code iz located.

Figure 37: Source Code Not Found Editor

... then you need to check your lookups in the Source Code Lookup tab. What this page
means is that the server stepped into a file but FusionDebug couldn't work out which file in
your Eclipse projects was associated with the one stepped info on the server. There are two
possible reasons for this:

® The project containing the source file is closed: If you read through the page, it will tell
you which lookups were attempted and will also let you know if you have any closed
projects. FusionDebug cannot show source code from closed projects. Make sure all
related projects are open.

® You are missing a mapping or have an incorrect lookup. At the fop of the page you
will see a button which will take you directly to the Source Code Lookup dialog. If you
click on this then you will see that the CF Server Folder has already been filled out. All
you need to do is enfer the Eclipse Project/Folder information and you can add a
new lookup.
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12 Reference

This section provides a feature reference for FusionDebug.

12.1 Debug View

The debug view reflects the state of the ColdFusion server being debugged.

Disconnect Step Into
Terminate Step Over
Resume Step Retumn
%5 Debug 2 W T E
O ] @ DR 3
Launched debug configuration —— = & Local Configuration [FusionDebug]

N - FusionDebug (localhost:8000)
Debug target L s

Suspended thread = MyComponent.cfc : METHOD() (ine:1)
Stack with two frames ’/{ = step_into.cfm (ine:5)

Elements of the Debug View

Launched debug configuration Displays the Debug Configuration used to connect to
the target.

Debug target Displays the target (machine and port) of this
debugging session.

Suspended thread If any threads are suspended because of a
breakpoint hit, they are displayed here. If the thread
is waiting for the server then you will see a status
message after the thread name. (Listed below.)

Stack with two frames Displays the stack of pages and CFCs involved in the
current request. Each page or CFC is displayed as a
frame, along with the function (if any) and line
number.

Disconnect Active on a configuration or target. Causes
FudionDebug to disconnect.

Terminate Active on a frame or thread, or configuration.

When clicked:
on a configuration, causes FusionDebug to
disconnect.
on a thread or frame, Causes the selected
thread to be stopped.

Resume Active on a targeft, thread or frame.
When clicked:
on a target, causes all suspended threads to
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resume.
on a thread or frame, causes that thread to
resume.

Step Into

If the Current Instruction Pointer (CIP) is located on
any tag which would cause a sub-page (CFC
constructor, CFC function invoke, page function, sub-
tag) to be called, Step Into instructs FusionDebug to
continue stepping inside that page. If the current tag
would not cause a sub-page to run, this is equivalent
to Step Over.

Step Over

Causes ColdFusion to execute the tag currently under
the CIP, then stop awaiting further stepping
instructions.

Step Return

Debug View Status Messages

If the CIP is currently located inside a sub-page (e.g.
A sub-tag) causes ColdFusion to finish running the
code inside the sub-page and return to the caller,
where execution will stop, awaiting further stepping
instructions.

The following status messages will appear after the Suspended Thread name to let you know

what is currently happening:

Waiting for CF Compiler

ColdFusion is currently compiling a page required for
the Step operation. The Debug View will update
once the compiler has finished.

Waiting for CF Classloader

ColdFusion is searching for and loading a page, CFC
or tag info memory. This often occurs after the
Waiting for CF Compiler message, as part of the
compile-load-run cycle.

Stepping

FusionDebug has asked ColdFusion to run the current
line, and perform the requested Step operation, and
is waiting for a report that the step has completed.

Waiting for Tag Validation

ColdFusion is currently validating a subtag, CFC or
invoked page. The Debug View will update once the
tag has been validated.
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12.2 Breakpoints View
This view displays all breakpoints set in the current session.

Breakpoints can be set in any supported file (ColdFusion / CFC source files) by right clicking
on the required line, and selecting Toggle Line Breakpoint, using the key combination ctrl-
shift-B, or with a double-click in the ruler to the left of the Code View.

Remove all breakpoints Go to file
Remove breakpoint T Skip all breakpoints
Variables | ® Breakpoints i . Expressions XR#PEw | mEE| YO

@ MyComponent.cfc [ine: 5] [Server File: c:\inetpubiwwwroot\cfapp\MyComponent.cfc)

® doimport.cfm [line: 1] [Server File: c:\inetpub\wwwroot\cfapp\doimport.cfm]
Breokpoin‘rs E— © step_into.cfm [line: 5] [Server File: c:\inetpub\wwwroot\cfapp\step_into.cfm]

@ types.cfm [line: 45] [Server File: c:\inetpub\wwwroot\cfapph\types.cfm]

Source lookup

Elements of the Breakpoint View

Breakpoints Lists all current breakpoints. Breakpoints can be
individually enabled or disabled using the check
mark, in which case they are displayed as an empty
circle: o

Each breakpoints specifies the file and line. Double-
click the breakpoint to locate it in an editor.

Remove breakpoint Removes the currently-selected breakpoint.  Also
available using the 'delete’ keyboard shortcut.

Remove all breakpoints Removes all breakpoints.

Go to File Locates the file containing the selected breakpoint in
an editor. Equivalent to double-clicking the
breakpoint.

Skip all breakpoints When selected, causes all breakpoints to be

temporarily disabled. Can be used with the Resume
command to run a page to completion without any
intervening breakpoints firing. When activated, all
breakpoints are displayed with a diagonal line: s,

Source lookup Real location of the file in which this breakpoint is seft.
Computed using the Source Lookup Tab of the
FusionDebug debug configuration. See section 11,
“The Source Lookup Tab” on page 41.
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12.3 Expressions View

This view displays any watched variables or expressions. Expressions can be entered by
selecting them in an editor, right-clicking and selecting Watch Expression, or by right-clicking
in the Expressions View and selecting Add Watch Expression.

Remove all expressions
Remove expressionw

Variables | Breakpoints |5’ Expressions 2 . i+t E ®eg ™ —0O
§§y ||Y.|| =g q" LrEn L |
=¥ "url" = Variable Scope
% LOCATION = "Stuttgart"
Y "now()" = "{ts '2006-12-20 10:49:42'}"

Expressions ——

Elements of the Expressions View

Expressions Lists the expressions which will be evaluated.
Remove all expressions Removes all expressions from the view.
Remove expression Removes the selected expression from the view.

Valid Expressions

Almost all ColdFusion expressions are valid. If an expression is valid in CF Scripf, it is a valid
Watch Expression. All variables, scope and structure references are valid:

+ url.username —the 'username' variable from the URL scope.
«  now() -theresult of the now () function - the current date and time
- y-—the value of the local variable 'y'.

-  http-the 'http' variable scope (this will be expandable to reveal its variables)

Evaluation

All expressions are evaluated whenever a thread pauses, either because it has hit a
breakpoint or as a result of a step action. During evaluation, the expression will display
“(pending)”.

Expressions can be manually re-evaluated by right-clicking the expression and selecting
Reevaluate Watch Expression.

Expressions can be disabled from evaluation by right-clicking and selecting Disable. The
expression will be tagged “(disabled)”.
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12.4 Eclipse Editor Context Menu

When right-clicking within a supported source code file in an Eclipse editor, three
FusionDebug elements are available, identifiable by their red FusionDebug tags.

Show In Alt+shift+w ¥
Paste Ctrl+V

Shift Right

Shift Left

# Toggle Line Breakpoint
# Set Variable

# Watch Expression

# Inspect Expression

Run As 4
Debug As »
Team 4
Compare With 4
Replace With 4
Preferences...
Elements of the Context Menu

Toggle Line Breakpoint Toggles a breakpoint af this line.

Set Variable Allows the user to set the value of a variable.

Watch Expression Copies the selected variable or expression to the

Expressions View and evaluates it.

Inspect Expression Immediately evaluates the value of any highlighted
expression and displays it in a window. (Note: This
feature is only supported on Eclipse 3.2)

Setting Variables
The Set Variable option allows the user to change the value of a variable.
- A variable must be selected in an editor before selecting this option.
« The value of the variable will be set in the currently-selected thread.
- The page running in that thread willimmediately see the new value of that variable.

« String values must be encapsulated in double quotes (“"Hello, world!”)
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- Expressions may also be entered — they will be evaluated and their result assigned fo
the variable.

This option is equivalent to running a <CFSET var=value> at the location of the Current
Instruction Pointer.
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12.5 Configuration Dialog

This section details the options available in the FusionDebug Launch Configuration dialog.

This dialog allows the user to specify one or more launch configurations: collections of
parameters used to connect FusionDebug to a target ColdFusion system. [t is accessible from
the Run -> Debug menu opftion, or by selecting Debug from the debug drop-down menu in
the Debug Toolbar, as shown in Figure 38.

5 ~ 2
& 1 Local Configuration

Debug As .4

#s Debug...
Organize Favorites...

Figure 38: The Debug Drop-Down Menu

The configuration dialog for FusionDebug connections is comprised of three tabs: Connect,
Source and Common. The Name: field is common to all three tabs, and specifies the name
of this configuration. The name is used in the Debug View to identify which configuration is in
use.
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12.5.1 Connect Tab

= Debug

Create, manage, and run configurations

FusionDebug needs to know about your CF Server to be able to debug your application

e =
= 0 -
=X B 5 MName: | Simple Debug Profile

type filter text —
ﬁ Connect $ Source Code Lookup | £51 Comman

& Edlipse Application
< Equinox OSGi Framewark CF Server Hostname and Debugger Port Mumber
= $ FusionDebug

Host: | localhost
ﬁ Simple Debug Profile

0] Java Applet Port: | 3000
[3] Java Application
Ju Junit [#] CF server is on Windows (uncheck if the CF Server is on Linux or Unix)

% Junit Plug-n Test
', Remote Java Application
= SWT Application

6] [ Debug ” Cloge

Elements of the Connect Tab
Host

Specifies the name of the host to which FusionDebug should connect, when this
configuration is launched.

Port

Specifies the TCP port on which the Java debug agent is listening. This is configured
(for standard ColdFusion installations) in the jvm.config file (see section 5.4.3: “The
Server Configuration Wizard” on page 26 and section 6.1: “Setting up ColdFusion for
Debugging" on page 29).

CF Server is on Windows (uncheck if the CF Server is on Linux or Unix)

Specifies the operating system of the CF server. Leave checked for Windows,
uncheck for Unix or Unix-like operating systems (Linux, Solaris etc.)
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12.5.2 Source Code Lookup Tab

= Debug

Create, manage, and run configurations

To debug your source code, FusionDebug needs to know where the files in Edipse are placed on your CF Server

MName: | Simple Debug Profile

type filter text —
g Connect @ Source Code Lookup = Comman

AddModify
Source Code in this Edipse Project/Folder...

4 Edipse Application
"" Equinox OSGi Framework

<Al Projects > v

u— - ...is placed in this CF Server Folder
4] Java Application
Ju Junit c:linetpub Wwwwroot\cfapp

Ji JUnit Plug-in Test

é Remote Java Application

[z SWT Application
Current Source Code Lookup

Edipse Project/Folder
Simple Project

CF Server Folder
cinetpubiwwwrooticfapp

[ Apply ] [ Revert

@ [ Debug

User Manual

The source code lookup tab allows one to specify where FusionDebug should attempt to
locate source code when a breakpoint fires, or a step into or step return action occurs. This
tab is also displayed when FusionReactor can't find a source file during Step operations.

When connected, changes to this data take effect immediately, and the Breakpoint View is
immediately updated with the new mappings. When disconnected, changes to this data will

be reflected when FusionDebug next connects.

Elements of the Mappings Tab
Upper Panel (Add/Modify)

The upper panel allows the insertion of new lookups, and modification of existing

lookups.

+ The Eclipse Project drop-down contains all open projects, as well as a global

All Projects mapping. The All Projects mapping is sufficient for simple projects,
and is a good starting point before adding more complicated mappings.

The Eclipse Folder drop-down contains all the paths for the project selected
in the Eclipse Project. If the All Projects mapping is selected, this drop-down
is disabled.

The CF Server Folder field should contain the exact path to the mapping
defined in the first two drop-downs from the point of view of the server. Any
Windows drive letters, Unix NFS mounts or symlinks should be as viewed by the
server ifself. It is possible o use the drop-down arrow in this field to select
previously-entered mappings.

Lower Panel (Current Source Code Lookups)

The lower panel displays existing mappings. To remove or edit an existing mapping,
select it by clicking on it, and click on Remove or Edit respectively.
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12.5.3 Common Tab
The common tab is not used by FusionDebug and can be ignored.
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13 Troubleshooting

This section lists answers fo some of the common problems encountered using FusionDebug.
You can also find support information, updates and articles at our website:

htp://www.fusion-reactor.com/fusiondebug/support.html

FusionDebug won't connect. The message is: “FusionDebug could not connect to the
target system (machine:port)”

« Check you have enabled Java debugging on a port that is available, and that
ColdFusion or JRun has started up correctly.

- If you are using a non-standard port (not 8000), make sure you have correctly
entered that port in the configuration dialog.

«  Make sure there are no firewalls or port restrictions in the network path between
you and the target system.

FusionDebug won't launch. The message is: “FusionDebug can only connect to one
target at once.”

- FusionDebug 2.0 is capable of attaching to one ColdFusion instance at a time.
Terminate your previous session (see “Terminafe" on page 51).

Expressions don't evaluate.

« The Expressions View can handle most expressions which are valid in ColdFusion.
A good rule of thumb is: if you can write it inside a CFScript block, or within “#"
characters, it's a valid expression.

«  Expressions are evaluated and re-evaluated only in the context of a suspended
thread. If no thread is suspended, expressions are not evaluated. If a thread is
suspended, try clicking on it. This will implicitly tell the Expressions View to re-
evaluate its expressions for that thread.

Expressions are listed as undefined.

- The Expressions View tried to evaluate the expression, but it either didn't return a
value (for function calls) or the variable referenced in the function was not visible
at the position the thread was suspended at.

I see lots of pages in the Debug View.

- These threads have suspended because of a breakpoint. Breakpoints fire
whenever a request hits them. If you see many pages in the Debug View, this is
because a web browser requested that page, and the page hit a breakpoint.

If you have a shared test server, we recommend disabling your breakpoints, or
activating “Skip All Breakpoints” (see “Breakpoints View", on page 53) after your
breakpoint has fired, so requests from someone else do not suspend.

Breakpoints don't fire.

- Check that FusionDebug is connected to your ColdFusion server (the Debug View
looks similar to “Figure 2: Debug Target” on page 16).

- Check that the breakpoint which should fire has been looked up correctly.
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The exact file in which this breakpoint is set is shown next to the breakpoint as
the Server File. If this is not showing the correct file, or shows “Breakpoint not

active. Edit Source Code Lookups”, edif your Source Code Lookups using the
Debug Configuration.
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